Desigo™ CC
Getting Started Version 2.1
Copyright Notice

Notice
Document information is subject to change without notice by Siemens Switzerland Ltd. Companies, names, and various data used in examples are fictitious unless otherwise noted. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Siemens Switzerland Ltd.

All software described in this document is furnished under a license agreement and may be used or copied only in accordance with license terms.

For further information, contact your nearest Siemens Switzerland Ltd. representative.

© Siemens Switzerland Ltd, 2015

Credits
Desigo, Desigo CC, Cerberus DMS, Cerberus PRO, and Sinteso are registered trademarks of Siemens Switzerland Ltd.

Other product or company names mentioned herein may be the trademarks of their respective owners.

Edition: 2015-06-30

Document ID: A6V10415475_en_a_21
Table of Contents

About This Document ....................................................................................................... 5

Document Revision History ............................................................................................. 9

1 Introduction .............................................................................................................. 10
  1.1 Client Options .................................................................................................. 10

2 First Steps ............................................................................................................. 11
  2.1 Starting the Client and Logging On ............................................................... 11
     2.1.1 Launching an Installed Client ......................................................... 11
     2.1.2 Launching a Web Client .................................................................... 12
     2.1.3 Launching a Windows App Client ..................................................... 12
     2.1.4 Cancelling System Initialization ....................................................... 13
     2.1.5 Troubleshooting the Logon Process .................................................. 13
  2.2 User Interface .................................................................................................... 14
     2.2.1 Graphical Elements and Controls ..................................................... 15
  2.3 Operating and Engineering Mode .................................................................. 16
  2.4 Operational Workflows .................................................................................. 17
     2.4.1 Basic Navigation Workflow .............................................................. 17
     2.4.2 Object Association Workflow ............................................................ 18
  2.5 Ending Your Session ....................................................................................... 19
     2.5.1 Exiting the System ........................................................................... 19
     2.5.2 Logging Off in Closed Mode ............................................................ 19
  2.6 Troubleshooting the Web Client and Windows App Client ................................ 20

3 Events ................................................................................................................... 21
  3.1 How Events Display in the System ................................................................ 21
  3.2 Handling Events ............................................................................................... 21
     3.2.1 Using Fast Treatment ....................................................................... 22
     3.2.2 Using Investigative Treatment ......................................................... 22
     3.2.3 Using Assisted Treatment .................................................................. 23
  3.3 Journaling Printouts ......................................................................................... 25

4 Graphics ................................................................................................................ 26
  4.1 Viewing Graphic Objects ............................................................................... 26
  4.2 Commanding .................................................................................................... 27
  4.3 Creating a Graphic ........................................................................................... 28
  4.4 Creating a Graphics Sub-Folder ....................................................................... 29
  4.5 Displaying a Graphic ....................................................................................... 29
  4.6 Commanding Properties in Graphics Viewer ................................................. 29
  4.7 Commanding Off-Normal Properties ............................................................. 30
  4.8 Editing a Graphic ............................................................................................. 30
  4.9 Deleting a Graphic Item .................................................................................. 31

5 Scheduler ............................................................................................................... 32
  5.1 Management Station Scheduling .................................................................... 32
     5.1.1 Adding a Management Station Schedule ........................................... 32
About This Document

Purpose
This documentation introduces a “first time user” to the Desigo CC management station, including the basics such as how to start up and log on. It describes the different system environments and client modes, the system workspace and provides high level examples of plant monitoring and navigation workflows. Included is a short overview and introduction to the most important features of Desigo CC, such as:

- Event handling
- Graphics
- Commanding
- Schedules
- Trends
- Reports
- Online Help system.

Also, a References section provides a list of the product documentation set, and useful support links.

Scope
This document applies to Desigo CC Version 2.1.

Target Audience
End-Users are the primary users of the system. Depending on the specific application, end users can be a building services engineer, a security guard, a member of the fire brigade, the facility manager, and so on. They are responsible for monitoring and managing the facility and any related events. They have the appropriate training for operating the management station.
**Liability Disclaimer**
We have checked the contents of this manual for agreement with the hardware and software described. Since deviations cannot be precluded entirely, we cannot guarantee full agreement. However, the data in this manual are reviewed regularly and any necessary corrections included in subsequent editions. Suggestions for improvement are welcome.

**Product Security Disclaimer**
Siemens products and solutions provide IT-specific security functions to ensure the secure operation of building comfort, fire safety, security management and physical security systems. The security functions on these products and solutions are important components of a comprehensive security concept.

However, it is necessary to implement and maintain a comprehensive, state-of-the-art security concept that is customized to individual security needs. Such a security concept may result in additional site-specific preventive action to ensure that the building comfort, fire safety, security management or physical security systems for your site are operated in a secure manner. These measures may include, but are not limited to, separating networks, physically protecting system components, user awareness programs, in-depth security, and so on.

For additional information on building technology security and our offerings, contact your Siemens sales or project department. We strongly recommend signing up for our security advisories, which provide information on the latest security threats, patches and other mitigation measures.

Document Conventions

The following table lists conventions to help you use this document in a quick and efficient manner.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Numbered Lists (1, 2, 3…) indicate a procedure with sequential steps. | 1. Turn OFF power to the field panel.  
2. Turn ON power to the field panel.  
3. Open the panel. |
| One-step procedures are indicated by a bullet point. | ● Expand the Event List. |
| Conditions that you must complete or must be met before beginning a procedure are designated with a ▲. Intermediate results (what will happen following the execution of a procedure step), are designated with an indented ➡. Results, after completing a procedure, are designated with a ➡. | ➡ The report you want to print is open.  
1. Click Print.  
⇒ The Print dialog box displays.  
2. Select the printer and click Print.  
⇒ The print confirmation displays. |
| **Bold** font indicates something you should type or select, or when a dialog box or window is specified. | Type F for field panels.  
Click OK to save changes and close the dialog box.  
The Create a New Project dialog box displays. |
| Menu paths in procedures are indicated in **bold**. | Select File > Text, Copy > Group, which means from the File menu, select Text, Copy and then Group. |
| File paths containing placeholders display the placeholders in *italics* enclosed in square brackets. | [installation drive]\[installation folder]\[project]\... |
| Error and system messages are displayed in *Courier New* font. | The message Report Definition successfully renamed displays in the status bar. |
| *Italics* are used to emphasize new or important terms. | The reaction processor continuously executes a user-defined set of instructions called the control program. |
| This symbol signifies a Note. Notes provide additional information or helpful hints. | For more information on creating flowcharts, see Flowcharts [→ 92]. |

Getting Help

For more information about the Desigo CC products, contact your local sales representative.
Safety Messages According ANSI Z535.6

The following examples show the ANSI standard safety messages used in this document to draw the reader’s attention to important information. ANSI distinguishes between personal injury safety messages and property damage warning messages.

The personal injury safety messages have safety alert symbols and the following alert level labels: DANGER!, WARNING!, CAUTION!

The label for property damage messages is: NOTICE.

Examples:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Message Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![](noticesticker.png) | NOTICE | Property Damage Warning Message  
Equipment damage or loss of data may occur if you do not follow a procedure or instruction as specified. |
| ![cautionsticker.png] | CAUTION | Caution Safety Message  
Minor or moderate injury may occur if you do not follow a procedure or instruction as specified. |
| ![warningsticker.png] | WARNING | Warning Safety Message  
Personal injury or property damage may occur if you do not follow a procedure as specified. |
| ![dangersticker.png] | DANGER | Danger Safety Message  
Electric shock, death, or severe property damage may occur if you do not perform a procedure as specified. |
Document Revision History

Document Identification
The document ID is structured as follows:
ID_Language(COUNTRY)_ModificationIndex_ProductVersionIndex
Example: A6Vnnnnnnn_en_a_02

<table>
<thead>
<tr>
<th>Modification Index</th>
<th>Edition Date</th>
<th>Brief Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a</td>
<td>2015-06-30</td>
<td>Market Release Edition</td>
</tr>
</tbody>
</table>
1 Introduction

The Desigo CC management station presents a single face to the customer for building automation, fire safety and security systems, or a combination thereof. Offering scalability of all configurations and allowing need-based expansion from small and medium to large and complex systems, Desigo CC provides customer and market-specific solutions.

For details about operating workflows, see the User Guide (A6V10415471). For details about configuration workflows, see the Engineering Manual (A6V10415473).

1.1 Client Options

The Desigo CC client is the user-facing application that the operator interacts with. A Desigo CC installation can have multiple clients, running on different computers. The Desigo CC client can be accessed in the following ways:

Installed Client
The user operates Desigo CC from a computer where the software is installed as a Windows application. Installed Clients can optionally be configured to run in Closed mode, which means that the operator cannot exit Desigo CC or switch to another application (no access to Windows Task Manager, Windows Taskbar, and desktop icons).

Web Client
The user operates Desigo CC as a web application that runs inside a browser.

Windows App Client
The user operates Desigo CC from a computer where a light Desigo CC application is downloaded and installed on-demand using a web browser.
2 First Steps
This section introduces you to the following topics:
- How to launch and log on to the Desigo CC client
- Overview of the system screen, including a brief description of the main features
- Basic operational workflows
- How to end your session

2.1 Starting the Client and Logging On
The way to start up Desigo CC depends on whether you are using an Installed Client, Web Client, or Windows App Client:
- To start Desigo CC Installed Client \(\rightarrow\) 11
- To start Desigo CC Installed Client configured to run in Closed mode \(\rightarrow\) 10
- To start Desigo CC Web Client \(\rightarrow\) 12 or Windows App Client \(\rightarrow\) 12

Make sure you know the exact client environment you should work with so that you can follow the correct procedure.

The first time you run the client, a licensing screen displays. You must accept the agreement to run the software.

You can log on to the system as a Desigo CC user or Windows user by providing the username, password and domain name.

![WARNING]

The current version of Desigo CC supports only one domain. This means that you can only log on to the configured default domain. If you belong to a domain different from the default, you can log on only as a Desigo CC user or local user ([station name]\(\rightarrow\) user name)).

The default domain name is configuration-dependent. If default domain name is not configured, the default station name and Desigo CC (not Windows user) are available as domain instead.

2.1.1 Launching an Installed Client
▷ You want to operate Desigo CC from a computer where the client software is installed.

1. Start Desigo CC from the Windows Start button or by clicking the icon on the desktop.
   ◆ The initialization splash screen displays for a few seconds. Then the logon dialog box displays.

2. Enter your username and password.

3. Select the domain.

4. Click Logon.
2.1.2 Launching a Web Client

- You want to operate Desigo CC as a browser-based web application.

1. Launch Microsoft Internet Explorer.

2. In the address bar of the browser, enter the name of the computer where the Desigo CC Web Server resides (for example, //ITP0990c/).
   
   **NOTE:** If you do not have this information, please contact your system administrator.

   - The Desigo CC page opens in the browser, and the Desigo CC tab contents display.

3. If you have already installed the authentication certificate, proceed to Step 4. Otherwise, proceed as follows:

   In the Desigo CC page, click the Support tab. Then select Web Client Application Certificate - Getting Started and follow the procedure to install the authentication certificate.

   - The system installs the certificate.

4. Click the Desigo CC tab, and select the Web Client thumbnail.

   - The initialization splash screen displays for a few seconds. Then the logon dialog box displays in the browser.

5. Enter your username and password.

6. Select the domain.

7. Click Logon.

**NOTE:**
The installation of the authentication certificate is required only once. The next time you can directly launch the Web Client.

2.1.3 Launching a Windows App Client

- You want to operate Desigo CC from a computer where the client software is downloaded and installed on demand from a browser.

1. Launch Microsoft Internet Explorer.

2. In the address bar of the browser, enter the name of the computer where the Desigo CC Web Server resides (for example, //ITP0990c/).

   **NOTE:** If you do not have this information, please contact your system administrator.

   - The Desigo CC page opens in the browser, and the Desigo CC tab contents display.

3. If you have already installed the authentication certificate, proceed to Step 4. Otherwise, proceed as follows:

   In the Desigo CC page, click the Support tab, and select Web Client Application Certificate - Getting Started and follow the procedure to install the authentication certificate.

   - The system installs the certificate.

4. Click the Windows App Client thumbnail.

   **NOTE:** If a security warning displays asking you if you want to install, click OK.
The installation of Desigo CC starts. When completed, the initialization splash screen displays for a few seconds. Then the logon dialog box displays.

5. Enter your **username** and **password**.
6. Select the **domain**.
7. Click **Logon**.

**NOTE:**
Each time you launch Desigo CC as a Windows App Client, a search for system updates is performed. If a new version of the software is available on the Web Server, you can choose to update it or continue using the previous version.

### 2.1.4 Cancelling System Initialization

When you launch the Desigo CC client, an initialization splash screen displays for a few seconds, before you are prompted to authenticate.

If you don’t do anything, when the initialization is complete, the logon dialog box displays.

Otherwise, you can interrupt the system initialization as follows:

- Click **Cancel** during the initialization splash screen.

  If you are working on a Web Client, Windows App Client, or Installed Client not in Closed mode, the Desigo CC client closes.

**Note:**
If you are working on an Installed Client in Closed mode, clicking Cancel during the splash screen will cause one of the following to occur:

- A message box informs you that connection to the **Closed Mode service** was cancelled, and the Desigo CC client will be restarted.
  - Clicking **OK** restarts the Desigo CC client (still in Closed mode).
- A message box informs you that the connection to the server was aborted. You can now decide whether to try reconnecting in Closed mode, or restart as a normal Installed Client (not in Closed mode) to investigate a possible connection problem:
  - Clicking **Yes** restarts Desigo CC as a normal Installed Client (not in Closed mode).
  - Clicking **No** causes Desigo CC to remain in Closed mode and continue trying to establish a server connection.

### 2.1.5 Troubleshooting the Logon Process

- During your authentication, if you enter an invalid username or password, your authentication will fail: a message box informs you that the entered credentials are invalid, and asks you to retry. After five failed attempts, another message box informs you that you have reached the maximum number of attempts allowed and the user authentication will close.
- An error message displays if the Desigo CC client cannot start because the **Client Profile** file was not found. Click **OK** to close the message box. See your System Administrator for assistance.
- When you log on, if no **client license** is available, the system will inform you and the Desigo CC client will not start. See your System Administrator for assistance.
2.2 User Interface

The exact screen layout will vary depending on your particular system’s configuration, and you may not see all the components described.

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Summary bar</td>
<td>The main point of entry to all the functions of the software. Provides an overview of the events in the system. It includes a set of indicators (event lamps) organized by event category, the system menu, icons for switching between windows and silencing alarms, and other general status information. For some configurations, when expanded, it also provides an Event Detail bar that highlights the most critical events in the system.</td>
</tr>
<tr>
<td>2</td>
<td>Work area</td>
<td>Large central portion of the screen below the Summary bar assigned to other management system windows or to the operating system desktop (such as Windows desktop) or to external applications (for example, Microsoft Internet Explorer, Microsoft Office programs, and so on).</td>
</tr>
</tbody>
</table>

In particular, depending on the operational workflow, the following windows can display in the work area:

- **Event List**
  A list of all the events in the building-control system. This is the starting point for viewing and handling events. The Event List is hidden and you can open it in the work area when needed by clicking its icon in the Summary bar.

- **System Manager**
  A multi-pane window for navigating, monitoring, and controlling all the components and subsystems of the site. Each pane contains a functional component of the management system (for example, a browser for navigating and selecting system objects, a viewer for displaying site floor plans, tools for scheduling tasks, and so on).

- **Investigative Treatment or Assisted Treatment**
  When you start to process an event, one of these dedicated alarm-handling windows may open in the main work area to help you take the correct actions.
2.2.1 Graphical Elements and Controls

Layout and Panes

The system screen can display many windows, some of which are made up of multiple panes, divided by splitters. A window can contain up to four panes. Each pane houses a functional component of the Desigo CC system (for example, a browser for navigating and selecting system objects, a viewer for displaying site floor plans, tools for inspecting the properties of objects, and so on).

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selection pane (vertically along the left). Also referred to as <em>Navigation pane</em>.</td>
</tr>
<tr>
<td>2</td>
<td>Primary pane (to the right of the Selection pane)</td>
</tr>
<tr>
<td>3</td>
<td>Secondary pane (opens when required, alongside the Primary pane)</td>
</tr>
<tr>
<td>4</td>
<td>Contextual pane (underneath the Primary and Secondary panes, divided into two parts)</td>
</tr>
<tr>
<td>5</td>
<td>Status bar. Along the bottom of the window, this bar displays status/update messages (Ready, Default loaded successfully, and so on).</td>
</tr>
</tbody>
</table>

Interacting with the Graphical Elements

You can arrange panes of a window in different layouts or interact with a window and its panes in various ways. These include:

- Click the icons on the window title bar top to minimize, restore down, or maximize the window.
- Click the icons on the window title bar to quickly switch between the available preset layouts:
  - : Selection, Primary, and Contextual panes. The Secondary pane displays only if it is already open.
  - : Selection, Primary, and Contextual panes.
  - : Selection and Primary panes.
  - : Primary, and Contextual panes. The Secondary pane displays only if it is already open.
  - : Primary pane only.
• Resize the panes in a layout by dragging the splitters, or expand/collapse a pane by clicking the button on the splitter.

• Click the icon to lock the window layout. When the layout is locked, clicking one of the layout icons will not have any effect; this means that you cannot change the current layout, and resize, expand, or collapse the panes of the window.

• Normally, the Secondary pane opens on demand, when you make a selection that requires it. When the Secondary pane opens, it takes up half the space that would otherwise be allotted to Primary pane. You can prevent the Secondary pane from opening by clicking the pushpin icon and locking the Primary pane. When the Primary pane is locked, any selections (such as Related Items) that would normally display in the Secondary pane are instead redirected to the Primary pane.

2.3 Operating and Engineering Mode

When you start the Desigo CC client, System Manager starts in *Operating* mode. This is the mode normally used for the day-to-day running of the building-control system. It enables you to monitor and control the facility, for example by verifying site statuses, handling alarms, checking graphics, generating reports, and so on. If you have appropriate user rights, you can also perform some limited configuration tasks (for example, editing graphics, schedules, and so on) in Operating mode.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System Manager <em>Operating</em> mode is identified by a light blue color.</td>
</tr>
<tr>
<td>2</td>
<td>Depending on the object selected in System Browser, the Primary pane displays only the Textual Viewer tab or the Textual Viewer and other tabs. Each tab gives access to the related operating application.</td>
</tr>
<tr>
<td>3</td>
<td>The Operating button is available only if you have access rights for Engineering mode; otherwise, it does not display. If available, this button lets you toggle System Manager between Operating mode...</td>
</tr>
</tbody>
</table>
Authorized users can switch System Manager to *Engineering* mode which is used to set up and configure the system.

![System Manager - Engineering Mode](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System Manager <em>Engineering</em> mode is identified by a light pink color.</td>
</tr>
<tr>
<td>2</td>
<td>Depending on the object selected in System Browser, multiple engineering tabs may display in the Primary pane header. Each tab gives access to a configuration application relevant to the selected object.</td>
</tr>
<tr>
<td>3</td>
<td>In the Contextual pane, the Extended Items tab displays next to the Related Items tab, and can contain additional contextual links useful for configuration tasks.</td>
</tr>
<tr>
<td>4</td>
<td>Toggle button to switch back to Operating mode.</td>
</tr>
</tbody>
</table>

For more details, see the *Engineering Manual* (A6V10415473).

### 2.4 Operational Workflows

This section introduces you to the most common workflows for navigating and interacting with Desigo CC.

#### 2.4.1 Basic Navigation Workflow

The following shows the typical workflow for navigating the system.

1. Select a view (1) in System Browser, in the Selection pane (for example, *Application View*).
   - The selected view displays in the System Browser tree.
2. Navigate the tree and select the object (2) you want to work with.
   - The information about the selected object displays in the Textual Viewer (3), in the Primary pane.
   - The properties of the selected object display in the Operation tab (4), in the Contextual pane.
   - Links to additional resources associated with the selected object display in the Related Items tab (5), in the Contextual pane.
3. Click a related item link (5) (for example, *New Remote Notification*) to open that resource in the Secondary pane.
   - The selected related item displays in the Secondary pane (6).

4. If necessary, click the icon (7) to display the navigation bar (8) with icons for moving back and forth between the most recent screens in the Primary pane and going back to the favorite location.

---

2.4.2 Object Association Workflow

The following shows the typical workflow for manual selection and drag-and-drop, in order to associate two objects.

1. Select a view (1) in System Browser, in the Selection pane (for example, *Application View*).
   - The selected view displays in the System Browser tree.

2. Navigate the tree to select the object (2) you want to work with (in this example, *Activity Log*).

3. Select **Manual Navigation** (3), to freeze the Primary pane (in this example, on *Reports - Activity Log*).

4. Drag and drop the selected object (4) (in this example, *Address Book*) to the Reports area.
2.5 Ending Your Session

Usually when you want to end your session you exit [➔ 19] Desigo CC. In Closed mode, you can only log off [➔ 19] from your session.

2.5.1 Exiting the System

▷ You are running Desigo CC (as an Installed Client, Web Client, or Windows App Client) and you want to end your session.

● In the Summary bar, select Menu > Exit.

▷ Desigo CC shuts down. If you were running Desigo CC in Internet Explorer, the logon dialog box displays on the screen.

2.5.2 Logging Off in Closed Mode

In Closed mode, you cannot shut down Desigo CC. You can only end your session, leaving Desigo CC running for the Default User.

1. In the Summary bar, select Menu > Logoff.

▷ A message box informs you that your Desigo CC will be closed and the Default User will be logged on.

2. Click OK.

▷ You are logged off and Desigo CC switches over to the Default User.
2.6 Troubleshooting the Web Client and Windows App Client

If there are connectivity problems, a message box may display indicating that the connection to the server was temporarily lost. Proceed as follows steps to resume working:

1. Click **OK** to close the message box.
   - The system automatically logs you off, and the logon dialog box displays again on the screen.

2. Try logging on again.
3 Events

Events are first detected by the sensors in the field according to the programmed thresholds and algorithms. The related field panel is responsible for the acquisition and local event signals, as well as transmitting the information to the management station where the operator can follow the prescribed treatment procedures and provide the required counter-measures to deal with the dangerous or abnormal condition.

3.1 How Events Display in the System

When an alarm occurs at your site, an event is generated and the following occurs:

- In the Summary bar, the event lamp for this category of events flashes, to alert you that there’s a new event to process.
- In Event List (when visible), a new event displays. It is graphically represented by a flashing event button.
- If the event that occurred meets specific critical criteria that require immediate attention, it also displays in an Event Detail bar (if available).

3.2 Handling Events

Desigo CC offers the following ways of handling events:

- Fast Treatment: directly send alarm handling commands (acknowledge, reset, and possibly other commands depending on configuration).
- Investigative Treatment: investigate the cause of an alarm by using all the system applications available for the alarmed point.
- Assisted Treatment: fully-guided alarm-handling support consisting of an operating procedure that provides a list of steps to follow.

NOTE:
Clicking an event button lets you access Fast Treatment. Depending on configuration, double-clicking initiates either Investigative or Assisted Treatment.

Navigating Event

When the selection in System Browser is on the root of a view, and there is at least one event in the system, you can use Textual Viewer to navigate to the point(s) in alarm. Double-clicking in Textual Viewer lets you drill down from parent to child nodes, to easily reach and identify the field point(s) in alarm.

Filtering Events

Before starting to handle alarm, you can filter the events in Event List to narrow down what types of events you want to view and handle.

- In the Summary bar, click Filter, and then select the type of filter you want to apply.

Removing Event Filters

If you want to remove any applied filter to view all the events:

1. In the Summary bar, click Filter.
2. From the Filter menu, select Remove Filter.

NOTICE! In FS_EN profile, the system automatically removes any applied filter when a new event occurs and it does not satisfy the event filter criteria.
3.2.1 Using Fast Treatment

The following procedure is recommended when handling an alarm that only requires sending specific commands. No further investigation or control action is required.

▷ An alarm occurs in the system, the event lamp relating to its category flashes in Summary Bar, and a new event button appears and flashes in Event List. The event status is Unprocessed, and the suggested action is Select the event.

1. In Event List, click the event button, for example: .
   - The event descriptor for the selected event appears highlighted to indicate that you have selected and started to handle this event. The event status is Unprocessed, the suggested action is Acknowledge event, and the acknowledge command becomes available.

2. Click **Acknowledge** .
   - The event is acknowledged, and the event status changes to either Waiting for condition or Ready to be closed. If it is Waiting for condition, wait until the physical conditions that caused the alarm are resolved and you can reset the field panel. Once the event status is Ready to be closed, the suggested action changes to Reset event, and the Reset command becomes available.

3. If the below commands are available in the event descriptor, do one or both of the following; otherwise, proceed to the last step of the procedure:

   - Click **Silence** , to silence the field panel.

   - Click **Start Remote Notifications** , to manually send a remote notification message.

4. Click **Reset** .
   - The event is reset, the event status becomes Closed, and the suggested action is Suspend event.

5. In Event List, click the event button.
   - The event is cleared from Event List.

3.2.2 Using Investigative Treatment

The following procedure is recommended instead of Fast Treatment when handling an alarm that requires investigation to determine its cause.

▷ An alarm occurs in the system, the event lamp relating to its category flashes in Summary Bar, and a new event button appears and flashes in Event List. The event status is Unprocessed, and the suggested action is Select the event.

1. In Event List, double-click the event button, for example: .
   - The Investigative Treatment window displays in the work area. The corresponding event source point is highlighted in System Browser, while Operation/Extended Operation displays the properties related to the point, and Related items any of the related-objects associated to the point.
2. Click **Acknowledge**.  
☞ The event is acknowledged, and the event status changes to either Waiting for condition or Ready to be closed.

3. If the below commands are available, do one or both of the following; otherwise, proceed to Step 4:
   - Click **Silence**, to silence the field panel.
   - Click **Start Remote Notifications**, to manually send a remote notification message.

4. To investigate the cause of the alarm, do the following:
   - In the Primary pane, check any content associated to the point in alarm (for example, a graphic).
   - If the event status is Waiting for condition, do whatever is necessary to clear the physical conditions that caused an alarm.
   - If necessary, click a Related Item link to open it in the Secondary pane, and perform the required action (for example, click a document link to view instructions).
   - Once the event status is Ready to be closed, the suggested action is Reset event, and the Reset command becomes available.

5. Click **Reset**.  
☞ The event is reset, the event status becomes Closed, and the suggested action is Suspend event.

6. In the **Investigative Treatment** window, click the event button.  
☞ The Investigative Treatment window closes and the event is cleared from the Event List.

### 3.2.3 Using Assisted Treatment

The following procedure is available in place of Investigative Treatment for situations where the operator must follow a specified sequence of steps to completely process and respond to an event. For example, such a procedure might include the following steps:

- View instructions or other important information contained in a document file or Web page.
- Check a graphic of the area where the event occurred.
- Send important event detail information using the remote notification message.
- Print details of the event.
- Generate and print a report.
- Fill out an event treatment report.

☞ An alarm occurs in the system, the event lamp relating to its category flashes in the Summary Bar, and a new event button appears and flashes in the Event List. The event status is Unprocessed, and the suggested action is Select the event.

1. In Event List, double-click the event button, for example:  
☞ The Assisted Treatment window displays in the work area, with the event details and treatment commands (Acknowledge, Reset, and so on) along
the top, and the operating procedure in the left pane. The operating procedure contains all the steps that must (or optionally can) be executed, presented in sequential order. The first step is already selected, and the Primary pane displays the appropriate tool for carrying it out.

2. Click **Acknowledge**.
   - The event is acknowledged.

3. If the respective commands are available, do one or both of the following; otherwise, proceed with the assisted treatment:
   - Click **Silence** to silence the field panel.
   - Click **Start Remote Notifications** to manually send a remote notification message.

4. Go through each step of the procedure, proceed as follows:
   a. Depending on how the system is configured, certain steps may be automatically executed when you initiate the Assisted Treatment (for example, automatically sending a remote notification message), or you instead have to select the step and perform certain actions (such as, filling out an event-treatment form) before you can check off that step.
   b. Once you have executed a step, depending on the system configuration, one of the following may happen:
      - If a gray check box displays next to the step, this means that you must first complete any required tasks (for example, printing the graphic of an area or filling out and saving an event-treatment report) before you check off that step.
      - If a white check box displays next to the step, this means that you can select it to check off the step. You can then continue Assisted Treatment by selecting the next step in the procedure, and again, performing the action required by the associated treatment tool. Complete all the remaining steps in the same way.
   - Once you have carried out the entire procedure, you can reset the event.

5. Click **Reset**.
   - The event is reset and you can close the event.

6. Click **Close**.

7. In the **Assisted Treatment** window, click the **event button**.
   - The Assisted Treatment window closes and the event is cleared from the Event List.
3.3 Journaling Printouts

The management system can be configured to print out a log of the system’s operation.

This printed log is called a Journaling Printout and can include:

- Alarms/events of the building control system (event logs)
- Actions taken by users or initiated by the management system (activity logs)
- Changes of value or changes of state of field points

The specific contents and appearance of the Journaling Printout are configured in an XML file called a journaling template.

When a Journaling Printout is configured on the system, printing may be initiated automatically and/or manually, depending on the type of printer installed:

- With a line printer, printing is always automatic and happens item-by-item.
- With a page printer, automatic printing starts when the number of accumulated items reaches the limit configured in the journaling template. (You can also manually start the printing before reaching this limit by clicking Flush in the Contextual Pane > Extended Operation tab).

The following is an example event printout of an alarm cycle.

### Journaling Printout of an Alarm Cycle

<table>
<thead>
<tr>
<th>Event Source</th>
<th>Event Source Message</th>
<th>Category</th>
<th>Assumed Source Path</th>
<th>Transition Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0_1 [Analog Output 1]</td>
<td>Alarm generated</td>
<td>Life Safety</td>
<td>System:Management View:Design CC.Fields</td>
<td></td>
</tr>
<tr>
<td>1/11/2012 12:02:00 PM</td>
<td>To alarm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/11/2012 12:02:00 PM</td>
<td>Alarm acknowledged</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/11/2012 12:02:00 PM</td>
<td>Alarm set to normal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/11/2012 12:02:00 PM</td>
<td>Alarm reset</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4 Graphics

The Graphics application allows you to create, view, store, and command large graphics representing equipment, floors, buildings, facilities, and entire campuses. These graphical representations can contain dynamic elements to represent devices or values you want to monitor or control. The three main components that make up the Graphics application are the Graphics Viewer, the Graphics Editor, and the Graphics Library Browser.

The Graphics application is located by selecting the **System Browser > Application View > Applications** tree. Project graphics are listed in the root of the **Graphics** tree.

**Graphics Viewer**

The Graphics Viewer is the component of the Graphics application that allows you to view the graphics representing your facility or equipment. It is where you can change the current state of an object's properties from a graphic, by using the floating Status and Commands windows. You can filter your view of a graphic by discipline, section, or you can zoom in and out for greater detail or for a birds-eye overview.

The Graphics Viewer is accessible by selecting **Systems Browser > Application Views > Applications** tree, and then clicking on the **Graphics**, or any one of the actual graphics in its root structure. The Graphics Viewer displays in the **Default** tab of either the Primary or Secondary pane. If you have the appropriate security access, you can access the Graphics Editor from the Graphics Viewer.

**Graphics Editor**

The Graphics Editor is the Graphics component that, with the appropriate security rights, allows you to create and modify simple as well as complex, dynamic graphical representations of your devices, facility, campus, or equipment. The Graphics Editor also allows you to test and simulate your dynamic graphics before going online with them. Graphics, Symbols, and graphic templates are all created in the Graphics Editor.

The Graphics Editor is accessible from the:

- Graphics Viewer, by switching from **Operating** to **Engineering** mode, or by clicking **Edit** from the Graphics Viewer toolbar.
- Graphics Library Browser, by right-clicking on a Symbol or Graphic Template thumbnail in the primary pane, and selecting **Edit**, or by clicking **Edit** from the Graphics Library Browser.

**Graphics Library Browser**

The Graphics Library Browser allows you to toggle between a view that displays all the available Symbols and graphic template objects in your project libraries. The Graphics Library Browser displays in the primary or secondary pane when you click on a libraries Symbol or Graphic Templates folder. It is also accessible from within the Graphics Editor as one of the views you can display in the dock panel.

4.1 Viewing Graphic Objects

The Graphics Viewer allows you to display dynamic graphics of your building control system. System Manager is the client application that hosts the Graphics Viewer. Within System Manager, you navigate the various views of System Browser to select the objects you want to display in the Graphics Viewer. System Browser displays only the objects in the system that you have access to, based on your user profile and privileges.
Primary and Secondary Selections
When you select a graphics object from System Browser, the Graphics Viewer displays the representative graphic. The selected object is considered the primary selection. The object properties also display in the Property Viewer. The graphic that has the primary selection displays the name of the graphic according to your Display selection in the System Browser, in the upper, left-hand corner of the primary pane. If any children of the primary selection are selected in the Graphics Viewer, the child name is added to the display name.

If you left-click on a Symbol on a graphic, the referenced object of the Symbol becomes the secondary selection. As a result the display of the Operations tab in the Contextual pane changes to correspond to the new selection. The System Browser, however, still displays the original, primary selection, to show your starting point.

When you select an object from System Browser that is associated with a graphic, the Graphics Viewer displays the representative graphic and the object’s associated Symbol on the graphic is selected. As a result, the Operations tab displays the object properties to correspond to the selection.

Double-clicking on a Symbol on a graphic makes the referenced object associated with the Symbol the primary selection in System Browser, and all workflows are updated accordingly.

4.2 Commanding
The Status and Commands window displays on a graphic, allowing you to change the current state of an object’s properties in your building control system. Access to objects is based upon the object privileges and privilege profiles set for you by your system administrator.

About Properties and Commanding
You change the current state of a property by commanding it. Once you command a property, the status of the command displays for the selected object. If the command fails, the reason for the failure displays so that you can take further action.

Examples of common commands:
- Acknowledge
- Change command priority
- Coldstart
Display of Properties on a Graphic
Properties display on a graphic in one of two ways—automatically or manually.
- They display automatically when a property goes into an off-normal state. The Status and Command window displays the icons associated with the properties in an off-normal state on the graphic. You expand the icon view to display the detailed property information and the command options.
- The Status and Command window(s) display manually when you right-click an object in a graphic that has data points associated with it. You can display multiple Status and Command windows in Graphics.

When a Status and Command window displays on the graphic, a connection line displays between the window and its associated objects on the canvas. The connection line between the Status and Command window and the object(s) remains intact, even when the window is moved around on the canvas.
Properties and commands also display in the Operation and Extended Operation tabs of the Contextual pane for the selected object.

4.3 Creating a Graphic
You want to create a graphic.

1. In System Browser, select Application View, and then navigate to and click on Graphics.
   ➤ The Graphics Viewer displays in the Primary pane and you are in Operating mode.
2. From the Graphics toolbar, click Edit.
3. From the Graphics toolbar, click Create New, and select New Graphic.
   ➤ A blank, tabbed untitled canvas displays in the Graphics Editor work area.
4. Create and design the graphic as necessary.
5. From the Graphics toolbar, click Save As.
   ➤ The Save As dialog box displays.
6. Navigate to and then click on the graphic folder you want to save the graphic in.
7. In the Name field, type a name for your graphic, and then click Save.
   ➤ The graphic is saved as a .CCG file. Additionally a .CCBAK back-up file is created and a .PNG
4.4 Creating a Graphics Sub-Folder

You want to create a graphics sub-folder.

1. In System Browser, select Application View, and then navigate to and click on Graphics.
   - The Graphics Viewer displays in the Primary pane and you are in Operating mode.

2. From the Graphics toolbar, click Create New, and click New Folder.
   - The New Folder dialog box displays.

3. In the Folder Name field, type a name for the new folder.

4. Click OK. One of the following occurs.
   - If you clicked on a folder, the new folder is created and added as a sub-folder.
   - If you clicked on a graphic, the new folder is created as a sibling of the graphic.
   - The folder is created and displayed in the Graphics folder in System Browser.

4.5 Displaying a Graphic

- You are in the System Browser, Application View, and are in Operating mode.

1. From System Browser, select Application View from the drop-down menu.

2. In the Selection pane, expand the Applications arrow.
   - The list of available applications displays.

3. Expand the Graphics folder, and click on the graphic you want to view in the Primary pane.
   - The selected graphic displays in the Primary pane of the Graphics Viewer.

4.6 Commanding Properties in Graphics Viewer

- You have a graphic open in Graphics Viewer, and you want to command the properties of an object in the graphic.

1. Right-click on the object, and select Status and Commands.
   - The system displays a list of the object's properties, their current state, value, status, and all commands available to you for this object, based on your system privileges and the configuration settings for the object.
   - If you select multiple properties to command, the selected properties display an icon with a triangular symbol in the lower right-hand corner.

2. If you selected multiple properties in the step above, click the triangular symbol on the icon next to the property you want to command. Otherwise, go to the next step.
   - The table row of the proper expands to show multiple instances of the property—one for each of the objects selected.

3. Click the command button that displays the command you want to execute.
   - If the command does not have arguments associated with it, the command is sent and the status displays.
4.7 Commanding Off-Normal Properties

You have a graphic open in Graphics Viewer, and one or more objects have properties in an off-normal state. The system has displayed the objects and the icons of the properties that are in an off-normal state. You want to view or command these off-normal properties.

1. Navigate to the Status and Command window associated with the object you want to command.
2. Click **Expander** to display the list of property information for the object.
   - The system displays a list of the object's properties, their current state, and all commands available to you for this object, based on your system privileges.
3. Click the command button that displays the command you want to execute.
   - If the command does not have arguments associated with it, the command is sent and the status displays.
   - If the command button has arguments associated with it, go to the next step.
4. Complete the required fields.
5. Click **Send**.
   - The system displays the status of the command.

4.8 Editing a Graphic

You want to edit an existing graphic. You have a graphic open in the primary pane.

1. From the Graphics toolbar, click the **Edit** button.
   - The **Graphics Editor** opens and displays in the work area.
2. Make modifications to the graphic as needed.
3. From the Graphics toolbar, click **Save As**.
   - The Save As dialog box displays.
4. Navigate to the appropriate folder where you want to save your graphic and type the new graphic **File Name** and from the **Save as Type** field, select the appropriate file type.
5. Click **Save**.
   - The graphic is saved.
4.9 Deleting a Graphic Item

You want to delete a graphic item, a graphic or a folder, from the Graphics folder.

▷ You are in Operating mode and the Graphics Editor is displayed.

1. In System Browser, select Application View, and then expand the Applications folder.
   ↦ The list of available applications display.

2. Expand the Graphics folder.

3. Navigate to and click the graphic or graphic folder you want to delete.
   **NOTE:** To select more than one graphic item, press **CTRL + click** on each graphic item you want to delete. The Graphics Viewer caption bar displays the name of the graphic item of the primary

4. From the Graphics Viewer toolbar, click Delete.
   ↦ The Delete dialog box displays.

5. Click Yes to confirm you want to delete the listed graphic item(s).
   ↦ The graphic folder is deleted and removed from System Browser.
5 Scheduler

The Scheduler component of the management system enables you to:

- Set up schedules to automate the operation of the building control site:
  Schedules are defined on a weekly and daily basis. You can specify a different
  hourly timetable for each day of the week. For example, you could schedule a
  heating system to work from 9 a.m. to 6 p.m. on Mondays and Fridays and
  from 8 a.m. to 8 p.m. on Tuesdays, Wednesdays, and Thursdays
- Set up exception calendars, which can be associated to schedules: Calendars
  define dates (or date ranges) during which a schedule does not apply. For
  example, you could create a holiday calendar that overrides the regular heating
  schedule to reduce energy costs. When you create a calendar, you can choose
  specific dates (January 15), a date range (August 1 – 31), or a week and a day
  you want the exception to run (third week of the month, on Wednesday). Then
  you can associate one or more schedules with the calendar.

You can configure schedules and calendars to execute:

- Centrally, on the management system (management station scheduling)
- Locally, directly on the BACnet field panel (BACnet scheduling)

You can set up multiple schedules and exception calendars to run at the same time.

5.1 Management Station Scheduling

Management station scheduling allows you to centrally configure daily or weekly
schedules, along with exception calendars, on the management system. The
management system can run multiple calendars or schedules at the same time.
Management station schedules run only if the management system is running, and
they are common to all the client stations of the management system. Management
station schedules handle both BACnet and non-BACnet objects.

Management station scheduling involves the following system objects, in the
Application View of System Browser:

- Schedules>Management Station Schedules
- Schedules>Management Station Calendars

5.1.1 Adding a Management Station Schedule

1. In System Browser, select Application View > Schedules > Management
   Station Schedules.
2. From the Setup tab, complete the following:
   a) From the Start Date drop-down list, select the start date for the schedule.
      Selecting the Any date check box defaults to the current date.
   b) From the End Date drop-down list, select the end date for the schedule.
      Selecting the Any date check box defaults to an infinite date.
3. Click the Outputs tab, and then drag objects from System Browser you want
   associated with the schedule.
4. From the Scheduler toolbar, click Save .
5. Complete the Name and Description fields.
6. Click OK.
5.2 BACnet Scheduling

BACnet scheduling allows you to automatically issue commands to field points at prescribed time intervals. You can create daily or weekly schedules (and exception calendars) for BACnet field panels. Each BACnet panel stores its own calendar and schedule objects, and a BACnet panel can store and run multiple calendars or schedules at the same time. Because BACnet schedules reside in and are executed by field panels, they run even if the management system they are associated with is not running. BACnet schedules handle only BACnet objects.

You can also configure commands to control one or more BACnet objects related to your BACnet schedules. For example, you might want to create a command that turns lights on and maintains the comfort room temperature only when the room is occupied. In this scenario, you could create a command with an entry for Occupied/Unoccupied, save it, and then drag it from System Browser to a schedule of your choice. The schedule will determine what time the command executes, the start and end dates, and the frequency of repetition.

BACnet Scheduling involves the following system objects, in the Application View of System Browser:

- Schedules>BACnet Schedules
- Schedules>BACnet Calendars
- Schedules>Commands

5.2.1 Adding a BACnet Schedule

1. In System Browser, select Application View > Schedules > BACnetSchedules.
2. From the Setup tab, select the Default value and the Data type, and then complete the remaining fields.
3. Drag objects from the System Browser that you want associated with the schedule, and drop them into the Outputs tab.
4. Complete the resulting display of fields as needed.
5. From the Scheduler toolbar, click Save 
6. Complete the Name field.
7. From the Field Device drop-down list, select the panel you want this schedule associated with.
8. Click OK.
6 Trends

A key functionality of a management system is the acquisition and recording of measured values from the customer site. For example, you might want to track the readings of:

- a room-temperature sensor over time
- the energy consumption patterns of an air cooling unit
- the status of an air handling unit

This kind of historical data is called a trend. The measured value (such as, a temperature) that you track in a trend is called a data point.

The Trends application lets you graphically view trends in a chart, called a trend view. You can assign one or more data points to a trend view to display their trends together on the same chart. You can also create multiple trend views and save them for later use.

The management system can acquire trend data in two ways:

- **Offline trend** data is recorded and stored locally, on the automation station. You can periodically upload offline trends to view them on the management system.
- **Online trend** data is instead uploaded continuously to the management system, and not stored locally on the automation station.

6.1 Online / Offline Trend

**Online Trend**

An online trend records real-time values from the customer site and displays them graphically in a trend view. The data values are sent to the Trends application upon each change of value.

### Record Online Trend Data

<table>
<thead>
<tr>
<th>Automation Station</th>
<th>Trend DB</th>
<th>Management Station</th>
</tr>
</thead>
</table>

Trend data is uploaded continuously to the management system and not saved locally on the automation station.
**Offline Trend**

Offline trends are used for the longer-term storage and retrieval of historical data to analyze a specific process or an entire facility. Offline trend data is recorded and stored locally, directly in the automation station.

<table>
<thead>
<tr>
<th>Phase 1: Record offline trend data</th>
<th>Phase 2: Upload offline trend data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend data is saved locally to a Trendlog object in the automation station.</td>
<td>Trend data is uploaded if:</td>
</tr>
<tr>
<td><strong>Phase 2:</strong> Upload offline trend data</td>
<td>• The max. buffer size is reached.</td>
</tr>
<tr>
<td><strong>Phase 1:</strong> Record offline trend data</td>
<td>• The number of defined entries is reached.</td>
</tr>
<tr>
<td><strong>Phase 2:</strong> Upload offline trend data</td>
<td>• Manually triggered by the management station.</td>
</tr>
<tr>
<td>64°F</td>
<td>Trend Log Object</td>
</tr>
<tr>
<td>Automation Station</td>
<td>54°F</td>
</tr>
<tr>
<td>Trend DB</td>
<td>Management Station</td>
</tr>
</tbody>
</table>

6.2 **Trend View Comparison**

Trend View comparison allows you to compare measured values from the same Trend View or with measured values from a second Trend View.

6.2.1 **Compare View**

You can link the same or another Trend View for data analysis that applies the same X-axis for the time range to both Trend Views. The current lower Trend View serves as the basis for the upper comparative Trend View. Any changes to the time range in the current Trend View are reflected in the comparative Trend View. Predefined buttons allow you to offset the comparative Trend View to the current Trend View by the selected value.
Trends
Example: Create and Store a New Trend View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current Trend View.</td>
</tr>
<tr>
<td>2</td>
<td>Compare View.</td>
</tr>
<tr>
<td>3</td>
<td>Time bar with time displayed in the comparative view.</td>
</tr>
<tr>
<td>4</td>
<td>No offset.</td>
</tr>
<tr>
<td>5</td>
<td>Predefined offset buttons.</td>
</tr>
<tr>
<td>6</td>
<td>Freely definable offset range (range, unit).</td>
</tr>
<tr>
<td>7</td>
<td>1x forward or 1x back for the selected offset range.</td>
</tr>
<tr>
<td>8</td>
<td>Freely definable offset range in hours, days, weeks, years.</td>
</tr>
<tr>
<td>9</td>
<td>Data Point Key</td>
</tr>
</tbody>
</table>

**Same Trend View**
This type of comparison is especially useful when analyzing the data for individual components, such as a room temperature for a room. The time offset allows you to easily check how the corresponding measured value behaves at the same time of day.

**NOTE:**
The legend displays the last left measured value in the time bar.
In the legend, the displayed value is not displayed based on the intersection of the time bar and trend curve. Instead, the time/date display is based on the time bar position.

### 6.3 Example: Create and Store a New Trend View

1. You are in the System Browser. Trends is still closed.
2. In System Browser, select **Application View**.
4. Click **New > New Trend**.
4. In System Browser, select **Management View**.

5. Select **Project > Field Networks > [Network Type] > Hardware > [Device]**.

6. Under [Device], find the data point whose trend you want to track in the new trend view (do not click the data point).

7. Drag-and-drop the data point to **Trends**.

8. *(Optional)* Repeat Steps 5 through 7 to add other data points to the trend view.

9. Click **Save As**.

   The **Save Object As** dialog box opens.

10. Select the [folder] where you want to save the trend view definition.

11. Type the **name** and **description** for the new trend view definition.

12. Click **OK**.

   In the System Browser under **Application View**, the new trend view definition is saved under **Trends > Trend View Definitions**.

   For each data point that you included in the trend view, an online Trendlog object is created under **Trends > Online Log Objects**.

### 6.4 Example: Analyze Trend Data

In a trend view, the data shown in the chart is normally updated automatically (continuous scrolling of the trend curves to show the latest values). If you need to perform a more detailed analysis, you can temporarily stop this automatic scrolling of the trend curves.

1. A trend view is open.

   **Click Stop**.

   This stops automatic scrolling of the data in the chart, and suppresses the symbol to update trend view.

2. In the trend view, move your cursor over the left or right slider (dark grey area) of the time range scrollbar.

   The mouse pointer changes shape and the tooltip displays.

3. Press the left mouse button and drag the time-range sliders to the left or right to define the time range to display in the chart (this defines how compressed your view of the trend data will be).

   The time range change is continuously displayed.

   The x-axis of the chart is adjusted to display the selected time range (displayed in the slider).

4. Move your cursor over the time range scrollbar (light grey area).

5. Press the left mouse button and slide to the left or right to shift the trend view forward or backward in time.

   The time range displays with the corresponding trend data.

6. When you have finished analyzing the data, click **Run** to resume the normal continuous updating of the trend data.
6.5 Using Comparative View

The comparative view is ideal for extended data analysis with time offset.

▷ You are in a Trend View and Manual mode is on.
▷ The property window of the Trend View is closed.
▷ The time period for display is defined using the time range scrollbar. For example, 12 hours.

1. Click Stop.
2. Click Compare View to open a comparative view. The same Trend View displays a second time.
3. Define the appropriate time/date range with the scrollbar.
4. Select time offset Forward or Backward.
5. Do one of the following:
   - Click one of the predefined offset buttons (for example, 1 hour).
   - Select your own range by selecting the dark button (for example, 3 hours) and select the time offset.
   ⇨ Comparison view displays with the corresponding time offset and measured values.
7 Reports

A report is a formatted and organized presentation of data. The Reports application lets you configure and produce a variety of reports on the functioning of the building control system.

To compose a report, you configure a Report Definition that specifies:

- The elements that you want to include in the report (such as tables, plots, logos, form controls, text and so on), and their layout.
- Appropriate filter(s): Name, Condition, Time, and/or Row to populate the elements of the report with information. For example, if you want a report on a room's activity data over the past month, you could define a Name Filter as well as Time Filter in an Activities table.
- The formatting you want to apply to the report elements, and the page layout.

You can also configure a Report Output Definition to specify the type of output (PDF or XLS), and the output destination (file, email, or printer).

Once you configure a Report Definition, you can save it for later use, run it, or schedule the report to be run at a specified time.

You can use reports as a reference or as a troubleshooting mechanism. Reports are helpful during system operation. For example, you can:

- View a mixed report containing:
  - A table displaying details of all active events for a floor of a building
  - A table displaying a history report of events
  - A trends plot displaying the temperature variations gathered from temperature sensors
- Export trend data for statistical analysis to:
  - An XLS file
  - A CSV file (according to the EMC requirement)
- Schedule production of a report using macros and reactions
- Send a report to someone using email, to a printer as a .pdf, or to a folder as a file

You can also export and import Report Definitions and logos. Pre-configured Report Definitions and associated logo files are available at:

...\GMSProjects\GMSMainProject\Data\Reporting

You can also create and configure reports for operating procedures. These reports are used during Assisted Treatment to enter information about how the alarm or event is being handled.

NOTE:

You cannot use trend plots and trend tables in reports for operating procedures, because these elements do not display any data when the report is executed from Assisted Treatment.

7.1 Reports Workspace

This section gives an overview of the Reports workspace.
### Reports Workspace

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System Browser</td>
<td>Displays all saved Report Definitions under the main Reports folder.</td>
</tr>
<tr>
<td>2</td>
<td>Reports Toolbar</td>
<td>Contains icons for performing various actions in Reports.</td>
</tr>
<tr>
<td>3</td>
<td>Reports Ribbon</td>
<td>Contains several tabs and group boxes to help you create a Report Definition. The tabs available on the ribbon are: Home, Filter, Layout, Data, and Settings. <strong>NOTE:</strong> The Reports ribbon is only visible when you create a new Report Definition or select an existing one.</td>
</tr>
<tr>
<td>4</td>
<td>Report Definition</td>
<td>Displays the following: Edit Mode: Workspace where you configure a Report Definition. Run Mode: Workspace where you view an executed report.</td>
</tr>
<tr>
<td>5</td>
<td>Report Management Section</td>
<td>Displays a report snapshot and documents for the executed reports.</td>
</tr>
<tr>
<td>6</td>
<td>Extended Operation Tab</td>
<td>Displays the properties of the selected Report Definition. The <em>Execute</em> button allows you to run a Report Definition. <strong>NOTE:</strong> You must configure a Report Output Definition for the selected Report Definition.</td>
</tr>
<tr>
<td>7</td>
<td>Related Items Tab</td>
<td>Displays the following: <em>New Report:</em> Opens a new Report Definition for configuration. Related Report: Displays the name(s) of the report(s) related to the selected System Browser object. Show-in-Related Items Report: Displays the name of the report(s) having the <em>Show In Related Items</em> check box selected.</td>
</tr>
</tbody>
</table>
7.2 Reports Workflow

This section describes working with reports in the Primary and Secondary panes, and the Contextual pane.

NOTE:
For Reports, you can perform the same tasks in Operating as well as Engineering mode.

Primary and Secondary Panes
In the Primary and Secondary pane, you can view and work with all types of reports and perform tasks that include:

- Create and configure a Report Definition by:
  - Adding various report elements
  - Configuring filters
  - Applying formatting
- Locate and modify a Report Definition (1)
- Run a selected Report Definition (2) or (5)
- View report execution status, document creation status, and so on during report execution (4), (8)
- Display generated report in Run Mode (3), (7)
- View a report as a PDF or XLS
- Export/Import a Report Definition
- Route a report to:
  - Folders as files (PDF/XLS)
  - Email recipients as a file attachment (PDF/XLS)
  - Local printers (PDF only)

If the Primary pane is unlocked (pushpin horizontal), then in the Secondary pane, you can work with three additional report types:

- New Report: When clicked, this link/icon opens a new Report Definition for configuration.
- Related Report: When clicked, this link/icon opens the report related to the selected System Browser object. (6)
- Show in Related Items Report: When clicked, this link/icon opens a report having the Show in Related Items check box selected. (6)

Contextual Pane – Extended Operation Tab
You can also run a selected report by clicking the Execute command button in the Extended Operation tab of the Contextual pane. (5)
Creating, Configuring, and Saving a Report Definition

1. In System Browser, select Application View.
2. In the navigation tree, select Applications > Reports.
   - Reports displays in the Primary pane.
3. In the Reports toolbar, click New.
4. From the context menu that displays, click New Report.
   - A new Report Definition opens in Edit mode.
   **NOTE:** If a default Report Definition template is available, then clicking New Report creates a new Report Definition based on the default template.
5. Configure the Report Definition by:
   - Adding various report elements such as tables, plots, texts, keywords, logos, and form controls.
   - Applying filters: Name, Condition, Time, Row, and Graphics.
   - Formatting the report elements and setting the page layout.
6. (Optional) Using the Report Output Dialog box, create a Report Output Definition for routing report outputs to:
   - A folder as a file
   - E-mail as a file attachment
   - A printer as a PDF file
7. In the Reports toolbar, click Save.
   - The Save Object As dialog box displays.
8. In the view structure that displays, select the destination folder under the main Reports folder.
9. Enter the Name and Description for the Report Definition.
10. Click OK to confirm (or Cancel to abort).
7.4 Generating a Report from a Report Definition

You can generate a report from a configured Report Definition either manually or automatically.

You can generate a report manually to display in the Reports workspace according to your login language (Run) or according to the selected language (Run As). Additionally, you can also generate a report manually by selecting a System Browser object, and clicking the link/icon in the Related Items tab for a Report Definition associated to that object.

To generate a report automatically, the Report Definition must have an associated Report Output Definition that specifies the report file format and output destination, such as a printer. You can generate a report automatically by using macros and reactions, or by clicking the Execute button.

You can optionally view and save manually or automatically generated reports as PDF and/or XLS files.

NOTE: If you generate any of the History reports such as Activity Log, Event Log, or Event Details Log and the system is over loaded, the data is logged in the History database with some delay. This leads to a delay in displaying data in such reports.

7.4.1 Generating a Report Manually using Run or Run as

▷ At least one Report Definition is available under System Browser > Reports.

1. In System Browser, select Application View.

2. Expand the Reports node.

3. Locate and select the Report Definition you want to execute.
   ▷ The Report Definition displays in Edit mode.

4. In the Reports toolbar, click one of the following:
   - Run to run the Report Definition according to your login language.
   - Run as to run the Report Definition according to the selected language. Localized data is retrieved and loaded in the cells of a table/plot in the report.

▷ The report execution status displays in the Report Management section below the report definition. On successful report execution, the generated report displays in Run mode.

NOTE: Clicking Report Management on the toolbar shows or hides the Report Management section.
7.4.2 Generating a Report Manually from Related Items Tab

1. Select an object from the System Browser tree. For example, Field Networks. This object is set as the name filter for the report definition you want to execute.

2. In the Related Items tab, select an icon/link for the Report Definition. For example, Object Status. You must import the report that you want to execute.

   NOTE: Do not select an icon/link for New Report as this opens a new Report Definition.

   The selected report displays in the Secondary pane in Run mode (if the Primary pane is unlocked – pushpin horizontal). The selected System Browser object is set as the Name filter for the table(s) and plot(s) present in the report. The report execution status displays in the Report Management section. On successful report execution, the generated report displays information related to the selected object.

7.4.3 Generating a Report Automatically

   At least one Report Definition for which a Report Output Definition is configured and available under System Browser > Reports.

1. In System Browser, select Application View.

2. Expand the Reports node.

3. Select the Report Definition you want to execute.

   The Report Definition displays in Edit mode.

4. Do one of the following:

   - From the Contextual pane, click the Extended Operation tab, and then click Execute.
   - Create a macro for a report definition and Execute.

   The report executes in the background when triggered (you have no visual indication that the report is being generated), and on successful execution, the report is routed to the destination configured in the Report Output Definition such as email, printer, or folder.

   NOTE: If you have not configured the destination in the Report Output Definition, the report is routed to the path specified in the location supervised folder in System Browser - Management View under Management System > Servers > Main Server > Report Manager > Report Default Folder.

7.5 Viewing a Report as a PDF or XLS

After executing a Report Definition manually or automatically, you can view and save the report as a PDF or Excel (XLSX) document.

This way you can share the PDF/Excel document with someone, or perform some calculations on the Excel document by applying Excel formulas.

You can either view the PDF, Excel/CSV documents and consecutive split documents (if any) in the Report Management section under the Report snapshot when you generate the report manually or you can locate them in the folder configured in the Report Output Definition dialog box when you generate the report automatically.
PDF

You can view and save the report output in a PDF document. A PDF document contains all the report elements of the Report Definition with output data and sorting applied. It also displays the special formatting applied to Report Definition elements (such as tables, plots, keywords, and so on). The PDF document can have a maximum of 500 pages, if the number of pages exceeds 500 the document splits into two.

NOTE 1:
To view a PDF document, you must have a PDF Reader installed on your computer (which is installed with the system).

NOTE 2:
Reports do not support TrueType collections for PDF generation.
To generate a PDF document for Asian languages, you must select TrueType fonts which support Asian characters in the Report Definition, for example, Arial Unicode MS.

NOTE 3:
You can print the PDF file by clicking Print on the Reports toolbar. This button is available when you click Create and view PDF on the generated report.
Excel (XLSX)

You can view and save the report output as an Excel (XLSX) document. An Excel document contains all of the reporting elements of the Report Definition with output data and user defined configuration (if applied). Form Controls (if present) in the report definition are not present in the Excel document. Any special formatting applied to the Report Definition elements are not retained in the Excel document.

If you have multiple tables or plots in a report definition, then the generated Excel document displays the details of each table or plot in a separate worksheet. Each worksheet also displays information on other reporting elements such as keywords and logos (if present) in the report definition. Each column in the worksheet has a combo box that corresponds to a table column that enables you to perform analysis on the table data. In case of an Event Details table the generated Excel document does not have any combo boxes as the data displays parent and child records.

However, if you remove the child columns from the Select Columns dialog box, run the report, and then generate the Excel document, only the parent records display and the columns display a combo box that enables you to perform data analysis.

In order to perform analysis on a specific set of columns in a table, you can add a PivotTable or chart to the generated Excel document and set this document as a template to the report definition having this table. When you run the report and generate the Excel document, information related to the columns you added to the PivotTable or chart displays in a separate worksheet.

The PivotTable or chart in the template must have columns of only those tables that are present in the report definition. For example, if you have a report definition with an All Logs table, the PivotTable or chart in the Excel document that is set as a template to this definition must have columns specific to the All Logs table only.

In case of an Event Details table, you must remove all the child columns for the PivotTable to be displayed.
An Excel document can have a maximum of 1000 worksheets (0 through 999). Each sheet can have a maximum number of 10,48,575 rows. If all the 1000 worksheets are filled with data, then a new Excel file is created for the next set of records.

**NOTE:**
To view and save an Excel document, you must have Microsoft Office Excel 2007 or later installed. Microsoft Excel is not installed with the management system.
8 Log Viewer

8.1 Overview of Log Viewer

The Log Viewer application lets you directly view the historical data of all management system activities and events without having to create and configure a report from the Reports application.

Log Viewer displays this historical data as a multi-column table that contains two types of records:

- Activity records concern actions done by users or by the system itself.
- Event records concern the alarms and events that appear in Event List.

Each record occupies a separate row in the table. You can extract a subset of this information by applying filters, selecting what columns to display, specifying the number of records to display, and so on. You can also apply other settings such as resizing the column widths, re-ordering the columns, and so on.

Once you configure all these preferences, you can save them as a log view definition for later use. When you access the log view definition the next time, you will see the latest data, presented and filtered according to all the settings you specified in the definition.

Log Viewer is covered by a license. To be able to access the Log Viewer application, you must have a valid Log Viewer license available in the management system.

8.2 Log Viewer Workspace

This section gives an overview of the Log Viewer workspace
### Item | Name | Description
--- | --- | ---
1 | System Browser | Displays all the saved Log View Definitions in Application View, under the folder Applications > Log Viewer. 
2 | Log Viewer Toolbar | Contains buttons for performing various actions in Log Viewer. 
3 | Log View | Displays the combined data from the activity log and event log. 
4 | Dropdown Arrow | When clicked, displays a menu with options to select columns, hide columns, apply filters, and remove filters. 
5 | Detailed Log Tab | Displays information related to system activities and events.

### 8.2.1 Contextual Pane - Detailed Log Tab

You can view information related to system activities and events through the Detailed Log tab in the Contextual pane.

**NOTE:** The Detailed Log tab in the Contextual pane is covered by a license. In order to view the information in the Detailed Log tab, you must ensure that the Log Viewer license is available in your system.

The information displayed in the Detailed Log tab is related to the following:

- **An object selected from the System Browser** - When you select an object from the System Browser, the Detailed Log tab displays the latest 100 activities for that object. For example, if you select an Analog Input object in the System Browser, the Detailed Log tab displays the latest 100 activities for the Analog Input object.

- **An object is selected in the Primary pane from any application such as Graphics, Trends, Textual Viewer, or Reports** - If you select an object in the
Primary pane from any application, the Detailed Log tab displays the latest 100 activities and event log records for the object.

- **An activity or event type record is selected from the log view** - When you select an activity type record from a log view, the latest 100 activities and event logs for the selected object display in the Detailed Log tab. However, if a record of type event is selected, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are displayed in the Detailed Log tab of Event List, Investigative Treatment, and Assisted Treatment windows.

- **Event handling** - When you select an event from the Event List, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are available in the Detailed Log tab of Event List, Investigative Treatment, and Assisted Treatment windows.

### 8.3 Log Viewer Workflow

This section describes the procedures for performing the following activities:

- Accessing Log Viewer
- Viewing Log Data

#### 8.3.1 Accessing Log Viewer from System Browser

1. In **System Browser**, select **Application View**.
2. Select **Applications > Log Viewer**.
   - Log Viewer displays in the Primary pane with the combined data from the activity log and event log.
8.3.2 Viewing Log Data
You can view log data using any of the following procedures:

- **Selecting the Log Viewer root node or a folder below it from System Browser** - This displays the combined data from the activity and event logs.
- **Selecting a saved log view definition from System Browser** - This displays the data, applying all the configurations you set up in the selected log view definition.
- **Selecting an object from System Browser** - This displays the activity and event log records pertaining to the selected object in the Detailed Log tab in the Contextual pane.
- **Selecting an object in the Primary pane from any application such as Graphics, Trends, Textual Viewer, or Reports** - This displays the latest 100 activity and event log records pertaining to that object in the Detailed Log tab.
- **Selecting an activity type or event type record in the log view** - When you select an activity type record from a log view, the latest 100 activities and event logs for the selected object display in the Detailed Log tab. However, if a record of type event is selected, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are displayed in the Detailed Log tab.
- **Selecting an event from Event List** - Displays information about the object involved in the event in the Detailed Log tab.

**TIPS:**
When you select the Log Viewer root node, a log view folder, or a saved log view definition from System Browser, you may see the following message above the log view table "Configured View Size reached! Refine search via Search Filter". This means that there are more records in the database than can be displayed in the defined view size. In order to view such records you must either specify filters or modify existing filters (if present).

8.4 Creating, Configuring, and Saving a Log View Definition

1. In System Browser, select Application View.
2. Select **Applications > Log Viewer**.
   - Log Viewer displays in the Primary pane with the combined data from the activity log and event log.
3. Perform the required configuration by:
   - Defining the log view size, selecting the columns to be displayed, reordering, resizing columns, and sorting log entries.
   - Applying condition and time filters.
4. Save the log view definition.
   - The log view definition is saved and displays in the System Browser tree.

**NOTE:** If you try to exit the configuration without saving the changes, the unsaved data message box displays.
9 Help System

The following help features are available to you at any time during your work session:

<table>
<thead>
<tr>
<th>Type</th>
<th>Provides...</th>
<th>Available using....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Online help. The functionalities similar to the standard HTML Help Viewer including:</td>
<td>Help item in the Menu on the Summary Bar or From the Windows Start menu:</td>
</tr>
<tr>
<td></td>
<td>● Search by category</td>
<td>Start &gt; All programs &gt; [Company] &gt; Desigo CC &gt; User Documentation &gt; [language specific] (such as, en-US)</td>
</tr>
<tr>
<td></td>
<td>● Search by subject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Search by keyword</td>
<td></td>
</tr>
<tr>
<td>Contextual help</td>
<td>A way to view the Help contents relating to any system application component contained in a window or pane on focus.</td>
<td>F1</td>
</tr>
<tr>
<td>User documentation</td>
<td>A list of the product documents available that describe how to perform system tasks. They are available if you prefer to work with a hard copy.</td>
<td>User documentation item in the Menu on the Summary Bar</td>
</tr>
</tbody>
</table>
References
See the following for system-related resources.

References to Product Documentation Set
The following is a list of the basic Desigo CC documentation set:

<table>
<thead>
<tr>
<th>Name</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>A6V10415475</td>
</tr>
<tr>
<td>User Guide</td>
<td>A6V10415471</td>
</tr>
<tr>
<td>Installing the Web Client Application Certificate</td>
<td>A6V10415479</td>
</tr>
<tr>
<td>Engineering Manual</td>
<td>A6V10415473</td>
</tr>
<tr>
<td>Graphics Editor Manual</td>
<td>A6V10415487</td>
</tr>
<tr>
<td>SNMP Application Guide</td>
<td>A6V10455382</td>
</tr>
<tr>
<td>OPC Integration Guide</td>
<td>A6V10415483</td>
</tr>
<tr>
<td>OPC Server Manual</td>
<td>A6V10415485</td>
</tr>
</tbody>
</table>

After successfully installing and launching the product, you can download the basic documentation set using the Menu in the Summary Bar. Installation of extension module documentation will depend on customer sites, and could add further manuals to the list of basic documentation (visible in the Menu – customized and tailored user documentation).
Support Addresses/Feedback/Links
The following contains important contact information for Desigo CC systems, as well as other useful links.

Customer Support
Support mailbox: fieldsupport-zug.ch.sbt@siemens.com.

Microsoft
General support about Microsoft Windows can be found at:
http://support.microsoft.com/directory/

Adobe Acrobat
To view PDF documents you need to install Adobe Acrobat Reader. You can find the latest free version at:
http://get.adobe.com/reader/